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Introduction

The Electrical and Computer Engineering department welcomes you to the Digital 
Logic Design Laboratory. The laboratory exercises will help the student become 
familiar with, and skilled in the use of, standard electronic test instruments.  Stu-
dents will learn to identify commonly used electronic components, specifically the 
TTL Family. Each student will also learn the practical uses and implementation of 
said components into circuitry. Each lab exercise has been designed to include four 
phases: prelab, simulation, experiment, and report. The prelab phase provides the 
student with the necessary information and practice needed to actually perform the 
lab experiment. The simulation phase is designed to give students practice using a 
computer program to design, test, and evaluate the circuits in the lab exercises. All 
measurements, test, and redesigns are done at the computer, which simulates the 
circuit(s) and their characteristics under ideal conditions. In the experimental phase 
each student will actually build the circuit(s) and make measurements to determine 
the circuit(s) characteristics. The experimental phase is very important as it gives 
the student hands on experience in component layout and wiring. Finally, in the 
report writing phase, students have the opportunity to discuss the results from the 
simulation and experimental phases. The report should include similarities and dif-
ferences, tell whether or not the experimental results fall within operational bound-
aries, and provide explanations for any differences. Keep in mind reports should be 
in formal format and always typed.

Laboratory grades will be calculated from the following guidelines.

PreLabs 25%

In Lab Work 30%

Quizzes 5%

Lab Reports 20%

Final Project 20%
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Laboratory Schedule

Week 

1. Introduction to Digital/Analog Trainer (Handout) Review of Fundamen-
tal Concepts and Intro to TTL Family (Chapter 1, Text) 

2. Introduction to Report Writing and Introduction to Altera Quartus II ® 
Computer Aided Design and Simulation Software (Handouts)

3. Basic Two-Level Circuits (Chapter 2, Text)

4. Implementation with One Gate Type (Chapter 3, Text)

5. Expression Reduction Techniques (Chapter 4, Text)

6. Make up Session

7. Multiplexors and Demultiplexors (Chapter 5, Text)

8. Binary Adders and Other Combinational Networks (Chapter 6, Text)

9. Design of Display Converter (Handout)

10. Latches and Flip-Flops (Chapter 7, Text)

11. Counters (Chapter 8, Text)

12. State Sequencers and Controllers (Chapter 9, Text)

13. Student Design (Simulation)

14. Implementation of Student Design 
3



Lab 1 (part a) 

Introduction to Elenco® Digital/Analog Trainer

Note that in the XK-550 trainer there are five major functions, (1) Power Supply (2) Logic Indica-
tors (3) Function Generator (4) Logic Switches and (5) Data Switches. Read through the controls 
below and locate them on the training board.

1. On/Off switch - Allows power to be applied to all outputs. 

2. Power output terminals - These provide 30VAC center tapped at 15VAC. They also provide output 
terminals for positive and negative variable voltages as marked.

3. Variable positive voltage control - Varies positive voltage from 1.25 to 20V at indicated output 
terminal.

4. Variable negative voltage control - Varies negative voltage from -1.25 to -20V at indicated output 
terminal.

5. 1 KΩ ( - undedicated potentiometer (variable resistor).

6. 100KΩ ( - undedicated potentiometer (variable resistor).

7. Waveform selection control - Allows user to select square, triangle or sine waveform output.

8. Output terminals - CLK and FREQ. Note the FREQ. terminal is for the waveform generator output.

9. Two logic switches - These are no bounce logic switches that give one signal state change per 
movement of switch.

10. Coarse FREQ - Selects from five ranges of frequencies for the generator output.

11. Fine ADJ control - Allows fine control of the function generator frequency.

12. Amplitude control - Controls the function generator’s output amplitude, 0-15Vpp.

13. DC offset control - Controls the DC level of the generator output. DC may be varied (10 volts from 
zero level. (Note zero level is center setting).

14. Input points for logic indicator LEDs. “A” input corresponds with “A” lamp, etc.

15. Logic indicators LEDs - Total of eight.

16, Eight data switches - Assigns output as 5V or 0V to corresponding terminal SW1-SW8 depending on 
position.

17. Two breadboards containing a total of 1660 tie points, including 6 independent bus lines.
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Using the Trainer

POWER SUPPLY 

Plug the trainer into a 120VAC outlet and flip the power switch to the “ON” position. The power 
switch should light. Using a digital voltmeter, set for a range of 20VDC, measure the voltage out-
puts at the DC power blocks only. For example, turn on your voltmeter and set its scale for DC 
volts, and set the voltage range for a max 20-volt reading. Connect the positive lead to +12 termi-
nal on the trainer and the negative lead to the GND (ground) terminal.  The +12V should measure 
between 11.4 and 12.6 volts. If it does not, ask your lab instructor for help. Repeat for the 5-volt 
and -12V terminals. The 5V supply should read between 4.75 and 5.25 volts. The -12V supply 
should read between -11.4 and -12.6 volts.

TESTING THE FUNCTION GENERATOR

To test the function generator, you will need an oscilloscope. Connect the scope’s channel 1 (or A) 
positive lead to the terminal marked FREQ. Connect the ground clip to the terminal marked GND. 
Turn the scope power on and set the VOLTS/DIV dial to 5V/DIV. Next, set the scope’s TIME 
SCALE to around 0.2 ms/Div.  Set the WAVE FORM switch on the trainer to sine, the COARSE 
FREQ. switch to 1 K and the AMPLITUDE control to maximum. Your scope should show a sine 
wave with an output of about 15Vpp. If you do not see a waveform, ask your lab instructor for 
help. If the sine wave is clipped (flat) on top or bottom, adjust the DC OFFSET control on the 
trainer until the sine wave is symmetrical. When you turn the FINE ADJ control, the frequency 
should vary between 100 and 1000 hertz. Try it.

Now, check the CLK output terminal. Connect a wire between the CLK terminal and input “A” of 
the logic indicators. Connect another wire between the FREQ terminal and input “B”. Set the 
COARSE FREQ. switch to 10 hertz and the FINE ADJ. control to its minimum position (all the 
way counter clockwise). The two LEDs should blink alternately.

TESTING THE LOGIC INDICATOR FUNCTION

There are eight logic indicators, which you will be checking out. Connect a wire to the 5V-power 
supply and touch the “A” logic indicator test pin. The “A” LED should light up. Remove the wire 
and the LED should go out. Do the same for the B, C, D, E, F, G and H test pins.

TESTING THE LOGIC SWITCHES

There are two logic switches and four conditions to be checked out. Connect a wire from the “X” 
test pin to the “A” logic indicator test pin. Connect another wire from the “Xbar” test pin to the 
“B” logic indicator test pin.

Apply power and note that the “A” LED indicator should be lit when the logic switch is in the “X” 
position and the “B” LED should not lit. Moving the logic switch to “Xbar” should reverse the 
indicator LEDs. The “B” LED should light and the “A” LED should turn off. Check the Y logic 
switch in the same manner.
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TESTING THE DATA SWITCHES

There are eight data switches to be checked. The outputs of the switch terminals are at 5V or 
ground depending on the switch’s position. Connect a wire between the SW1 terminal and the 
“A” logic indicator test pin. The “A” LED should light when the switch is placed toward the top 
case or the on position. Repeat the same test on SW2, SW3, SW4, SWS, SW6, SW7 and SW8.

How to Wire A Circuit. The following procedures should be used as a guide to assist you in 
wiring your first few circuits. 

• Verify power is OFF.
• Insert TTL chips into the breadboard.
• Connect (5V) power and ground to each chip.
• Using your simulation printout as a wiring guide, complete the circuit.
• Inspect your circuit, comparing it to the simulation diagram to verify each wire is connected 

correctly.  If necessary, refer to the pinout diagrams for each chip located in the back of your 
lab manual.

• Turn on the power and test your circuit.
• Turn power OFF before any rewiring of your circuit is attempted.

This completes the testing of the trainer. Continue to part b (chapter 1, in your 
laboratory manual).
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Introduction to Lab Report Writing

Introduction

A laboratory report is intended to carry back to the reader information about what was done in the 
laboratory experiment. It should be neat, concise, well organized, and clear. Avoid writing a 
report that contains material non-relevant to the experiment. Laboratory reports are graded on 
quality, not on quantity.

An admirable report can be written by considering the reader and what they need to know. A sim-
ple check for evaluating your report is to give it to an engineering student and ask them to read it 
and answer the following questions:

What was the objective of the lab?
What steps were taken to realize the objective?
What were the results of the lab?
What conclusions were drawn from the results?

If the answers are clear and complete, you probably have a good report. If the answers were vague 
and incomplete, then it is recommended that you rewrite your report.

Laboratory Report Format

The laboratory report that you turn in must be typed. Use complete sentences and make it easy to 
read. Follow the format given to you in this manual. The major criteria used in evaluating a report 
include; good procedure and results, report accuracy, good organization and data presentation, 
and the reporter’s ability to form meaningful conclusions.

You may use the word-processing and graphic facilities located in Room EB 228 (or other campus 
computer labs) to write your report.

The following is a general report format. It is necessary for your lab reports to include all sections 
in bold type as titles and subtitles. However, each student’s writing style will vary and you are not 
expected to follow a canned writing format that may be awkward for you.

Cover Page 

Your name and the date the experiment was performed.
Course Number and Section.
Experiment Number and Title.
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Sections and information to be included in all reports

1. Introduction       
This section should consist of a paragraph or two stating the objective of the experiment and how 
the objective is to be reached. Avoid writing long, vague and unrelated sentences. Show your 
communication skills and get the meaning across. The introduction should answer the questions:

What is to be studied?
What is the purpose of this experiment?
How the purpose is to be accomplished?

2. Theory and Analysis
This section should consist of related theory and your prelab or theoretical analysis results. 
Include any mathematical expressions and laws related to the experiment here.  The theory sec-
tion of the laboratory manual, your text books, and material presented by your lab instructor are 
good sources of information needed to complete this section. If you had to look in other sources 
for additional information, be sure to reference the source you used.

3. Procedures
The procedures for the experiment are given in the laboratory manual. If there were any devia-
tions in the procedures from those given in the manual, they should be mentioned here in detail. If 
you have followed the procedures given in the manual exactly, then reference this section to the 
lab manual and experiment title.

4. Results
In this section, the data obtained during the experiment should be presented. The presentation of 
the data should be in the form of tables or graphs. You may need to include the truth table and the 
wave diagram. The main idea of this section is to present the results of the data collection as 
clearly as possible. Anything unusual, which happened during the course of the experiment, must 
be mentioned here.

In addition, any calculations that were necessary to obtain the results should be presented here. It 
is not necessary to write down all calculations made. A sample calculation and explanation should 
be presented. Be sure to indicate the units in both the results and example calculations.

5. Discussion and Conclusion
This section discusses the significance of the results. The similarities and differences between 
your prelab (or analysis), simulations, and experimental results should be noted and discussed. 
Specifically, what were the differences, their causes, and do your results fall within operational 
boundaries?

Your conclusions should be an extrapolation of the experimental results into the “ real world “. 
They should answer the question, “How can the techniques demonstrated or the results obtained 
effectively be utilized by a practicing engineer?” The answer requires some thinking and insight 
into the experiment. Remember that your report should contain your own engineering judge-
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ments, discussions, conclusions and possibly recommendations. Do not simply restate the high-
lights of the results without adding your own thoughts.
Note: Any subsets of the main sections should carry a (Section.Subsection) heading. For example:

Theory and Analysis

2.1 Theory

2.1.1 OR Gate

2.2 Analysis

2.2.1 OR Gate Table

2.2.2 Timing Analysis

Appendices
All the information that supports your report, but is not included in the text of the report should be 
here. This information may include the prelab (or analysis), simulations, schematics, raw data and 
repetitive calculations.
                                           

DATA PRESENTATION HINTS
1. In general, data is best presented in either tabular or graphical form. This organization gathers all the 

data so that the reader can make comparisons and draw conclusions on their own. 

2. Spreading data over several pages of the report is unprofessional and must be avoided. No reader likes 
to hunt for the data he is supposed to compare. If you reference a graph or table in the text of your 
report, tell the reader where it is.

3. Tables and graphs should be readable. Do not attempt to put them very close to the bottom or next to 
the binding.

Tabular Format:
a) Tables are a good means of comparing several measured values. For example, voltage 

across different elements of a circuit is easy to compare if they are presented in a table.

b) All tables should be given a designation (i.e. Table XXX) and a title (for e.g., Truth table 
for AND gate).

c) An example of an acceptable table is given below.

INPUT OUTPUT

X Y OUT
0 0 0
0 1 0
1 0 0
1 1 1

Truth Table 1: AND Gate
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Introduction to Altera Quartus II Computer Aided Design 
and Simulation Software

by Dennis Hite, B. Earl Wells

Objectives:

In this lab, you will use the Altera Quartus II ® CAD software to create a schematic diagram of 
your design after which you will use its simulation capabilities to produce complete timing dia-
grams that will help you understand and verify the functionality of your design. You will be creat-
ing a simple logic circuit as an exercise.

What is Altera Quartus II CAD Software?

The Altera Quartus II ® CAD development software is a fully integrated programmable logic 
design environment. This easy-to-use tool supports virtually all of Altera ® programmable device 
families and works in both the PC and UNIX environments. It supports, design capture, simula-
tion, timing analysis, and design synthesis. In this class you will utilize the design capture, and 
digital simulation capabilities of the Altera Quartus II ® software.

How can I get access to the Software?

There are two options for getting accessing the software. One is to use the software that is 
installed in the electronics labs. The other is to visit the Altera web site at 
       https://www.altera.com/support/software/download/altera_design/quartus_we/dnl-quartus_we.jsp
and download the Quartus® II Web Edition Software. The Web Edition software contains the 
same basic functionality as the commercial version. You can use the software for 30 days on a 
trial basis but you will probably want to download the free license file which will give you 
approximately 6 months of free usage. Follow the directions on the Altera web site for details on 
activating this license. This option is mentioned only for your convenience and UAH is not liable 
for any activities concerning the use of the software that you download.

Getting Started

There are many Quartus® II  file types, four of the most common include:

Block Description Files (bdf) = schematic or block diagram
Vector Waveform File (vwf) = timing diagram entry or display File
Block Symbols File (bsf) = symbol or schematic component
Hardware Description File (tdf, vhd, v) = AHDL, VHDL, or Verilog File -- alternative higher 

level way of capturing your design.

To complete the exercises in this course, you will be concerned mainly with creating a Block 
Description File (bdf) and a Vector Waveform File (vwf) file. The (bdf) file is where you will 
place your logic schematic that represents your design. After you have created your (bdf) file you 
will need to compile it. Finally after successfully compiling your project, you will need to drive 
the inputs of your design (i.e. stimulate it) during its simulation and to choose which output sig-
nals you would like to view in the timing diagram. This will be accomplished when you create the 
vector waveform file (vwf) which will show the timing diagram for both your selected inputs and 
outputs after you simulate your project.



Part A: Setting up the work environment

1 Before entering the Quartus II ® CAD software place your personal USB flash drive in the 
computers USB port. This is where you are to store your design files for this lab. It is sug-
gested that you use a USB flash thumb drive that has a capacity of 32 Mbytes or greater. 
Make sure that you are careful with this drive and that you exit the Quartus II ® software and 
properly stop the drive before you remove it from the PC or you may have loss of data. It is 
the student’s responsibility to properly backup his/her flash drive. Throughout this tutorial it 
is assumed that Windows ®  maps your flash drive to the device labeled h:. If this is not the 
case you should substitute the actual drive letter for the h: labeling presented here. 

2 To open the Quartus II ® CAD tool package, double click with the left mouse button on the 

Altera Quartus II ® icon on your desktop. Note that the exact version number of Quar-
tus II may not match the one shown here but this tutorial should still be valid for your version 
of the software. You will then see a welcome screen that is similar to that in Figure 1.

3 Next left-click on the New Project Wizard which is under the File Menu.

Figure 1

Figure 2
11



4 An information window similar to the one shown in Figure 3 will appear, left-click on Next 
to continue.

5 A dialog box similar to the one shown in Figure 4 will then appear. In the first field of it enter 
the name of the working directory such as h:\example1 as shown in the figure. Then enter 
the name of the project. The project contains all the pertinent information about the design. 
In this case enter the name comb_logic in the following field. Notice that as you enter this 
name it also is being entered in the bottom field where will be used to indicate your top-level 
design file. The Quartus II tool supports hierarchical design methodologies that allows the 
user to use many files to represent the entire design. In this course we will only use a single 
top-level design file which will have the same name as the project. This is the default so sim-
ply left-click on Next after you have entered the name of the project in the second field.

Figure 3

Figure 4
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6 If the working folder (h:\example1 in this example) is not present then a warning message 
window will appear asking you if you want to create the file. In this case simply left-click on 
the Yes button to continue. The next New Project Wizard window will then give you the 
opportunity to add more files to the project (as shown in Figure 5). You do not want to do 
that at this time because you have not yet created the schematic file (you have no files to 
add). Simply left-click on Next to continue to the next screen.

7 The New Project Wizard will then display the Family & Device Setting window which will 
allow you to select a programmable logic device to configure with your design (i.e. load your 
design into). We will generally not be using such a device in this course but to make sure that 
all the simulations work in the same manner go ahead and select the FLEX 10K Family, and 
the EPF10K20RC240-4 device as shown in Figure 6. This device is the Field Programmable 
Logic Array, FPGA, device that may be used in one of the latter labs to rapidly prototype 
your design. After the Family, and Device is selected you can exit the wizard by left-clicking 
on the  Finish button.

Figure 5
13



Part B: Entering a Schematic

Entering the Block Editor
1 After you have exited the New Project Wizard, you will want to enter the schematic diagram 

for the comb_logic example. To do this, first select New from the File menu. This will bring 
up the file type box that is shown in Figure 7. Then highlight the Block Diagram/Schematic 
File option and press the OK button. 

Figure 6

Figure 7
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2 This will bring up the Block Editor as shown in Figure 8. On the right hand side of the block 
editor is the location of the graphics window work area where you will create your sche-
matic. The name of this graphics window is tentatively set by the software as Block1.bdf but 
this will be renamed to the name of your project when you save your schematic the first time. 
Double click with the left mouse button somewhere in the Block Editor’s work area to select 
a component to enter in your design or select the Insert Symbol option from the Edit Menu. 

Entering Components
1 Before you can enter a component, you will need to choose it from the appropriate compo-

nent library of symbols. In the previous step you brought up the Symbol Window which has a 
list of such library components in the left hand side of the window. To reveal the components 
expand upon the c:/altera/.../quartus/libraries entry by left-clicking on the symbol next to 
it. This will reveal the megafunctions, other, and primitives component library symbol ele-
ments where:

megafunctions: (larger customizable parameterizable logic components such as multipliers, 
adders, decoders, multiplexers, counters, and special i/o components)

others: (7400 equivalents, SSI, legacy MSI components)
primitives: (gates, flip-flops, I/O pins, VCC, GND symbols, etc.

Now choose a 2-input AND gate from the primitives library. You can do this by expanding 
the primitives library to reveal the logic sub-library as shown in Figure 9 (i.e. select 
c:\altera\...\quartus\libraries\primitives\logic). Once the and2 component is selected left-
click the OK button and then left-click the place in the graphics window work area of the 
Block Editor where you would like to place the component as shown in Figure 10.

Figure 8

+
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2 In this example our design is a two-level logic schematic made up of a level made up of three 
2-input AND gates that feeds into a single 3-input OR gate. Once you have selected the first 
AND gate you can cut-and-paste a copy in the normal windows manner. First, using your 
mouse, right-click on the and2 gate that you just added then scroll down and then right-click 
on Copy as shown in Figure 11. 

Figure 9

Figure 10

Figure 11
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3 Then choose a position below the original and2 gate, right-click, then scroll down and left-
click on Paste as shown in Figures 12-13 (ctrl+x and ctrl+v also work).  

4 Now repeat the procedure to add a third and2 gate. You can move components by selecting 
the component and holding down the left mouse button while dragging.

5 Now add a 3-input OR gate (or3) to the right of the second (middle) and2 gate. Use the same 
procedure you used to select and add your first and2 gate.

6 Next, wire the outputs of all three and2 gates to the inputs of the or3 gate. To add the first 
wire, point to the output pin of the first and2 gate, click the left mouse button and hold it 
down while dragging the wire (line) toward the top input of the or3 gate. Once the wire is 
touching the or3 input pin release the mouse button. Make sure that there are no visible gaps 
in the wire. Figure 14 shows how your design should look after wiring the first and2 gate to 
the or3 gate.

Figure 12

Figure 13
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7 Repeat the procedure and connect the remaining outputs of the two remaining and2 to the 
unattached or3 inputs. Note that components and wires may be relocated as needed by drag-
ging them with the mouse.

Defining Input and Outputs
1 Your logic design will have one or more input and outputs that define its interface with the 

outside world. In Quartus II® these I/O lines must be wired-from or wired-into special com-
ponents that are named input, output, or bidir. It is also desirable to give these I/O compo-
nents descriptive/user defined names. To accomplish this first double click using your left 
mouse button on an empty space within the graphics window work area.

2 Next, select the special input component from the Altera component library. You can do this 
by expanding the primitives library to reveal the pin sub-library (i.e. select 
c:\altera\...\quartus\libraries\primitives\pin). Then select the input component and left-click 
on the OK button as shown in Figure 15..

Figure 14

Figure 15
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3 Then left-click on the place in the graphics window work area of the Block Editor where you 
would like to place the component.

4 Make five copies of the input component and connect all six of these components to the three 
and2 components using wires in the manner described previously.

5 Next select an output component from the same pin sub-library (i.e. select 
c:\altera\...\quartus\libraries\primitives\pin)

6 Connect the output component to the output of the or3 gate. 
When you are finished all of your inputs and outputs should be wired as shown in Figure 16.

7 The next step is to give user defined names to your inputs and output. For this example give 
your inputs the names I0 through I5 by double clicking on the “pin_name” text of each input 
symbol and then typing the appropriate new name. In the same manner label the output com-
ponent O. If you miss the pin_name area of the input or output components but click on the 
component itself a Pin Properties dialog box will appear and the name can be entered in the 
Pin name(s): field as shown in Figure 17. In this case, just click on the OK button after enter-
ing the name. 

Figure 16

Figure 17
19



The final schematic is shown in Figure 18. 

8 Now you need to save the schematic (bdf) file and include it in your project. To accomplish 
this select Save from the File menu. This will bring up the Save As window as shown in Fig-
ure 19. Notice that the default file name is the same as the project name (comb_logic) and 
the Add file to current project option is automatically selected. This is what you desire so 
simply accept the defaults and left-click on the Save button.

Congratualtions, you have now completed your first schematic block diagram.

Figure 18

Figure 19
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Part C: Compiling the Project

1 After you enter your schematic you will need to compile your project before you can begin 
simulation. Compiling the project creates the internal information that the simulator needs to 
understand the logic makeup of your circuit (it also, in this case, creates a file that can be 
used to load the design in the selected programmable logic device but we will be only using 
its simulation capabilities here). To compile your project, first left-click on the icon or 
select the Start Compilation which can be found under the Processing menu. The compila-
tion process will then begin and a window similar to the one shown in Figure 20 will appear. 

2 After the compiliation is complete if there are no errors you should see a window similar to 
that shown in Figure 21. Left-click on the OK button to continue.

Note: you can review the warnings (and any compilation errors) by clicking on the Warning 
(or Error) tab at the bottom of the Message window. Warnings need to be evaluated closely 
to determine if they are important to your design. In most cases in this class warnings can be 
ignored. Errors on the other hand always have to be fixed before you can proceed to the other 
phases of the design flow (in our case simulation). If you have a compilation error first 
examine the error message and if you are not sure of its meaning then ask your lab instructor 
for help. 

Figure 20

Figure 21
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Figure 22 shows an explanation of the four warnings generated and in this case none of them 
will affect the simulation of our design. 

When compilation errors or warnings that must be fixed occur, they can be fixed by modify-
ing the schematic (bdf) file. You can access the schematic again simply by left-clicking on 
the appropriate tab (comb_logic.bdf in this example) in the Quartus II® window.

Part D: Simulating Your Design

Simulation is a process in which the functionality of your design can be demonstrated using a 
computer without the need to actually implement the design in hardware. Simulation has the 
advantage that it allows you to determine the correct operation of your design without the 
need to prototype it in hardware. Simulation also allows you to verify timing, and to test for 
conditions which may be destructive if the design were actually implemented in hardware. 
One of the major drawbacks of simulation, though, is the amount of time that it takes to sim-
ulate complex circuitry, which can be several orders of magnitude slower than the actual exe-
cution time of the corresponding hardware. It must also be remembered that simulation only 
approximates the behavior of actual circuitry at a certain level of fidelity. The real operation 
of an actual circuit may differ. With that said, though, simulation is a very powerful tool that 
is often a very accurate indicator of the actual behavior of digital designs.

Creating the Timing Diagram
1 To create a timing diagram you will first need to enter a Vector Waveform File (vwf) which 

will be used in the simulation process. This file will allow you to specify the values of your 
inputs over time and select the outputs that you would like to monitor in your simulation. In 
the comb_logic example you will use this file to drive the 6 inputs and to monitor the single 

Figure 22
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output. To input a vector waveform file, first select New from the File menu. This will bring 
up the File Type box that is shown in Figure 23. Then highlight the Vector Waveform File 
option and press the OK button.

2 This will bring up the Waveform Editor window. Double click with your left mouse button in 
the white space under the Name Field of the Master Time Bar in this window to bring up the 
Insert Node or Bus dialog box that is shown in Figure 24. This box is where you are to enter 
the I/O signal names for the design. 

3 Next left-click on the Node Finder button. This will cause the Node Finder window to appear 
as shown in Figure 25. Then left-click on the List button of this window. This will cause the 
list of possible input and output nodes to appear in the left hand side of the window (which is 
also shown in Figure 25). From this list you can select individual nodes or a group of nodes 
to be included as part of your timing diagram. In this example will select all seven nodes (I0-

I5, and O) to be included. To do this press the  button which will copy all  the signals 

Figure 23

Figure 24
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present under the Nodes Found: area of the window over to the Selected Nodes: area . Then 
left-click on the OK button to continue.t

4 After you exit the Node Finder window you should re-enter the Insert Node or Bus dialog 
box with the Name: and Type: fields both being set at “Multiple Items” as shown in Figure 
26. Do not make any changes to this box. Simply left-click on the OK button to continue.

5 When this is done the Name field of the Waveform Editor will contain the names of all of the 
I/O signals as shown in Figure 27. The next step is to enter the input waveforms using the 
waveform editing tools. This can be accomplished by first maximizing the Waveform Editor 
window along with the timing diagram area of this window to give you the most room possi-
ble to perform your work. The upper axis of the timing diagram area of the Waveform Editor 
contains the simulation time that an input or output is to occur. You can enter the desired 
input waveform graphically by selecting the portion of the wave that you desire to be driven 

logic high or low and then left-clicking on the appropriate button   or  button. Figure 
27 illustrates this process for the case where the I2 input is being set to high for the time 
period 240.0 ns to 320.0 ns. Here this segment is highlighted using the left mouse button 

after which the   button will be pressed causing this segment of the waveform to be a 
Forcing “logic” High (1). 

Figure 25

Figure 26
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It is important to note that the scale of the waveform can be adjusted by using the Zoom In or 
Zoom Out options under the View menu (or by pressing the ctrl+space or ctrl+shift+space 
keys). It is also important to note that the Quartus II ® software assumes nonzero delays for 
circuit elements which can sometimes cause some monetary glitches (called hazards) to 
appear in the waveform output. To avoid these affects it is a good idea not to have a signal 
change its state no faster than about 50 ns in your simulations.

6 Now enter the complete waveform that is shown in Figure 28. Notice that the output wave-
form O does not change from the X (unknown) state when you are entering the input wave-
forms. This is because we have not yet performed the simulation.

Figure 27

Figure 28
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Grouping Signals

1 Often you may desire to group a set of signals together so that they can be viewed collec-
tively as a bus. This can be accomplished by first selecting the signals by holding down the 
left most mouse button while dragging vertically over the desired signal names in the wave-
form editor and then selecting the Group option from the Grouping sub-menu that is under 
the Edit menu as shown in Figure 29 

Note that you can also access the group option by right-clicking after you highlight the signal 
names instead of going to the Edit window.

2 After you have grouped the signals the Group dialog box will appear. You are then to enter a 
group name (I for this example) and the specified Radix (which is set to binary in this exam-
ple) as shown in Figure 30. We selected binary in this example but often you may desire to 
display signals in decimal, hexadecimal, or evan ASCII. Left-click on OK to continue. 

The default way of displaying grouped I/O signals is to assume the uppermost signal is the 
least significant signal in the grouping. Figure 31 illustrate that this is the case for the signal 
group I that we just made. If you group signals together you can still view them separately by 
expanding the signal by clicking on the symbol in the Name field.

Figure 29

Figure 30

+
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To reverse the order of this grouping first left-click on the group name I, then right-click the 
mouse and highlight the Group and Bus Bit Order option which will reveal the LSB on Top, 
MSB on Bottom option. Left-click on this option. You can reverse the bit order for any radix 
you have chosen. You can also manually drag and drop the order of the signals in the list 
before you group them by left-clicking on the signal name and dragging it to the desired 
position in the window.

Changing the Waveform End Time

The default end time for the waveform is set at 1 us. In some cases the end time may need to 
be increased. If this is the case, you can change it by selecting the End Time option from the 
Edit menu.

Saving the Vector Waveform File

1 Before you can run the simulation you will need to save the vector waveform file you just 
entered. You can save it by selecting the Save option from the File menu. The first time you 
save the file it will bring up the Save As dialog box as shown in Figure 32. 

Figure 31

Figure 32
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The first time you create a vector waveform file its default name will be set to the same as 
your project name and the Add file to Current Project option will be checked. That is what 
you will usually desire so simply press the OK button to continue.

Running the Simulator
1 Once you have exited from the Waveform Editor, having saved your vector waveform file, 

you can now run the simulation. To do this left-click on the  icon on the tools bar or select 

the Start Simulation option under the Processing menu (or press ctrl+i). The simulator will 
then run and produce a set of simulation reports which are accessible on the left hand side of 
the window. Upon successful completion of the simulation you will be prompted as shown in 
Figure 33. Left-click on the OK button to continue.

The resulting timing diagram should then appear with the output updated to reflect the result 
of applying the input waveform to your circuit. Figure 34 shows this result for the 
comb_logic example.

Figure 33

Figure 34
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2 You can view the details of the timing diagram, all 6 input values, by expanding the input 
nodes by left-clicking on the symbol that is next to the group name I. Figure 35 shows the 
expanded waveform for the comb_logic example.

Lab Assignment: Print out your final timing diagram and check it. Verify that the output makes 
sense given your circuit and these inputs. Then write a truth table for your timing diagram for 
all verifiable entries. How many inputs were verified by the simulation? How many possible 
inputs were not verified?

This completes this tutorial. All of your future labs will call for a project simulation. You will nor-
mally follow the same procedures as discussed here. That is:

1. Set up your design project

2. Enter your schematic in a block description file.

3. Compile your design.

4. Enter the input waveform, simulate your design, and analyze the timing diagram.

+

Figure 35
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Part E: Lab Work

1 Using Altera Quartus II ®, enter the schematic shown in Figure 36 and create a timing dia-
gram that drives the three inputs in all possible ways (exercises the circuit exhaustively). 
Then verify that the timing diagram is correct by comparing it to the expected truth table. 
Turn in a copy of the schematic, final timing diagram, and your truth table as directed by 
your lab instructor.

After checking with your lab instructor, close all open files and exit the Altera Quartus II® 
software.

Figure 36
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Lab 9 (Handout)

EE 203

Design of a Display Converter

Two-Level Optimization and Simulation
The purpose of this laboratory is to illustrate how the two-level logic combinational design tech-
niques introduced in the EE 202, Digital Logic Design class can be applied to a simple design 
problem. The laboratory requires that students use Karnaugh map minimization techniques to 
generate the logic necessary to display a specified four-bit code on a seven segment display unit. 
Students will then evaluate the correctness of their design in the lab through computer simulation. 

Background
A single seven-segment indicator can be used to display the digits ‘0’ through ‘9’ and the hexa-
decimal symbols ‘A’ through ‘F’ (with symbols ‘b’, and ‘d’ being displayed in lower case format) 
by lighting up the appropriate set of segments. For example, the number ‘8’ can be displayed by 
illuminating all seven segments and the lower case letter ‘b’ can be displayed by illuminating the 
segments labeled c,d,e,f, and g for the seven segment display element that is shown in Figure 1.:

One common type of seven segment display unit utilizes Light Emitting Diodes, LEDs, as 
the display elements. In this arrangement, each segment that makes up the seven segment display 
unit is a separate LED that will light up when it is forward biased1. Often commercially available 
seven-segment LED display units minimize the number of external pins needed by internally con-
necting together one node of each of the seven individual LEDs. In one arrangement, the common 
anode configuration, the anodes of the segment diodes are all connected together in the other 
arrangement, common cathode, the cathodes of the diodes have a common connection point. If the 
common point of a common anode seven segment LED is connected to VCC (5 Volts in standard 
TTL logic) and a set of current limiting resistors are connected in series with the individual seg-
ments, as shown in Figure 2, then each segment of the display can be independently illuminated 
by placing a logic low on the corresponding segment lead (assuming the logic device is capable of 
sinking enough current to light the LED). In a similar manner if the common point of a common 
cathode seven segment LED is connected to ground and a set of current limiting resistors are con-
nected in series with the individual segments (see the Note in Figure 2) then each segment of the 
display can be independently illuminated by placing a logic high on the corresponding segment 
lead (assuming the logic device is capable of sourcing enough current).

a
b

c
d

e

f
g

Figure 1: Seven-Segment Display Element

1The features of diodes are discussed in much detail in other EE classes. At this point in time it is sufficient to know that a 
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diode is an electronic device that allows positive current to flow in only one direction -- the direction indicated by the arrow 
present on the diode’s schematic symbol. In an ideal diode, when a positive voltage is applied between the diode’s anode (non-
pointed end of diode symbol) and the cathode (pointed end), the diode will be forwardly biased and current will flow in the 
direction of the arrow. LEDs are just special case diodes that light up when they are forwardly biased. 
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In this laboratory exercise its is assumed that a common cathode seven segment LED will be used 
as the targeted display element with the common cathode point being connected to ground. Thus a 
logic high will be required to light up each segment. In the next laboratory, where a prototype 
design is to be actually implemented, a common anode LED will be used (the reason for this 
design change will be described later) so a basic overview of both types of seven segment LEDs 
has been presented.

Figure 3 shows a simplified system schematic of a display converter circuit being used to drive a 
seven-segment display. The display converter circuit must contain the logic necessary to drive the 
seven segment display in a manner in which the symbol associated with the four bit input is dis-
played. The symbol pattern that is displayed depends upon the actual four bit code that is being 
implemented. The most common example would be to display a symbol associated with the 8-4-
2-1 weighted binary value that is associated with the four input lines. Thus the symbol 0 would be 
displayed if all of the input bits were logic low, and the symbol 8 would be displayed if bit I3 was 
high and the rest low. This is an example of the standard 8-4-2-1 weighted code, but others are 
possible and may be useful in certain situations. Tables 1-6 illustrate four possible four bit codes 
that could be implemented and displayed on a seven-segment display.

VCC

R

R

R

R

R

R

a

b

g

a

b

g

7 Seg LED 7 Seg LED

cp cp

Logic Low
Lights

Segments

Logic High
Lights

Segments

Common Anode Common Cathode
Note: In a real world diode, the current must be limited or the diode will overheat and be destroyed. This is usually accom-

plished using a set of current limiting resistors all with a resistance value of R, as shown in the figure. The value of R 
can be computed using Ohm’s law from the diodes characteristics given in the data manual and the targeted supply 
voltage. A too large a value of R will result in a too dimly lit display and a too small of a value of R will result in a 
damaged part. Practical values of R for this application lie between 100 Ohms and 500 Ohms.

Figure 2: Seven-Segment Display Element
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Circuit to be

Digital Logic
inputs
from
toggle
switches

I3
I2
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O3
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b

c
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f
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Figure 3: Display Converter Seven Segment Display System Overview
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Table 1: Standard Binary 8-4-2-1 Weighted Code

Inputs Display
Configuration

Inputs Display
ConfigurationI3 I2 I1 I0 I3 I2 I1 I0

0 0 0 0 1 0 0 0

0 0 0 1 1 0 0 1

0 0 1 0 1 0 1 0

0 0 1 1 1 0 1 1

0 1 0 0 1 1 0 0

0 1 0 1 1 1 0 1

0 1 1 0 1 1 1 0

0 1 1 1 1 1 1 1

Table 2: Complemented Input 8-4-2-1 Weighted Binary Code

Inputs Display
Configuration

Inputs Display
ConfigurationI3 I2 I1 I0 I3 I2 I1 I0

0 0 0 0 1 0 0 0

0 0 0 1 1 0 0 1

0 0 1 0 1 0 1 0

0 0 1 1 1 0 1 1

0 1 0 0 1 1 0 0

0 1 0 1 1 1 0 1

0 1 1 0 1 1 1 0

0 1 1 1 1 1 1 1
33
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Table 3: Binary Coded Decimal (BCD)

Inputs Display
Configuration

Inputs Display
ConfigurationI3 I2 I1 I0 I3 I2 I1 I0

0 0 0 0 1 0 0 0

0 0 0 1 1 0 0 1

0 0 1 0 1 0 1 0

0 0 1 1 1 0 1 1

0 1 0 0 1 1 0 0

0 1 0 1 1 1 0 1

0 1 1 0 1 1 1 0

0 1 1 1 1 1 1 1

Table 4: Complemented Input Binary Coded Decimal (BCD)

Inputs Display
Configuration

Inputs Display
ConfigurationI3 I2 I1 I0 I3 I2 I1 I0

0 0 0 0 1 0 0 0

0 0 0 1 1 0 0 1

0 0 1 0 1 0 1 0

0 0 1 1 1 0 1 1

0 1 0 0 1 1 0 0

0 1 0 1 1 1 0 1

0 1 1 0 1 1 1 0

0 1 1 1 1 1 1 1

Display
Blanked*

Display
Blanked*

Display
Blanked*

Display
Blanked*

Display
Blanked*

Display
Blanked*

Display
Blanked*

Display
Blanked*

Display
Blanked*

Display
Blanked*

Display
Blanked*

Display
Blanked*
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Table 5: Gray Code

Inputs Display
Configuration

Inputs Display
ConfigurationI3 I2 I1 I0 I3 I2 I1 I0

0 0 0 0 1 0 0 0

0 0 0 1 1 0 0 1

0 0 1 0 1 0 1 0

0 0 1 1 1 0 1 1

0 1 0 0 1 1 0 0

0 1 0 1 1 1 0 1

0 1 1 0 1 1 1 0

0 1 1 1 1 1 1 1

Table 6: Excess-3 Code

Inputs Display
Configuration

Inputs Display
ConfigurationI3 I2 I1 I0 I3 I2 I1 I0

0 0 0 0 1 0 0 0

0 0 0 1 1 0 0 1

0 0 1 0 1 0 1 0

0 0 1 1 1 0 1 1

0 1 0 0 1 1 0 0

0 1 0 1 1 1 0 1

0 1 1 0 1 1 1 0

0 1 1 1 1 1 1 1



Prelab Assignment
In this experiment students will be required to derive the two level AND/OR logic that is needed 
to implement a display converter for ONE of the codes described in the previous tables. Students 
are to perform this minimization before entering the laboratory using standard Karnaugh Map 
techniques. 

The four inputs to the display converter network (I3, I2, I1, I0,) shown in each of the previous 
tables represent a particular type of binary code which can be displayed by the seven segment dis-
play. Each student is to implement a display converter circuit for ONE of the codes described by 
the previous tables. The particular code to be implemented will be assigned to individual students 
by the laboratory instructor. The code assignment is shown below:

You are to implement the code represented by Table ____.

Again, in this work assume that a logic high (“1”) will light up a segment and a logic low (“0”) 
will turn off the segment. Then complete the following tasks before coming to the lab.

a) create seven separate truth tables one for each segment of the seven segment LED. Each 
truth table should have the same four inputs (I3, I2, I1, I0) and one output (O6, O5, O4, 
O3, O2, O1, or O0 as defined by the system level connection pattern shown in Figure 3). 
The truth tables should describe the desired Boolean behavior needed to implement the 
assigned binary code.

b) convert each truth table into a Karnaugh map then derive the minimum Sum-of-Prod-
ucts Expression (SOP) for each output. Present the resulting seven Boolean equations to 
your lab instructor. 

Upon entering the lab students are to present the seven truth tables and the set of minimized equa-
tions to the lab instructor. Students who have not completed these prelab steps will not be allowed 
to participate in the laboratory.

Laboratory Assignment
Using schematic capture, each student is to enter the design that corresponds to the set of 
minimized equations that was developed in the prelab assignment by using the appropriate 7400 
series library elements that are present within the Altera Quartus II design package (refer to the 
library c:/altera/.../quartus/libraries/others/maxplus2). Students are allowed to use multiple input 
AND gates, OR gates and inverters. Students should test their designs using an exhaustive set of 
test vectors (i.e. the inputs should take on all sixteen possible values). Each student should 
demonstrate this design to the lab instructor. The laboratory instructor may also require that your 
design be downloaded into programmable logic to verify your design. Your laboratory instructor 
will then give you instructions on how to proceed. To facilitate the downloading of designs into 
programmable hardware students are expected to use the same I/O signal names that are given in 
this handout  (i.e. I0-I3 for the inputs, and O0-O6 for the outputs).
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